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1 INTRODUCTION TO 
HOLTER LX 
ANALYSIS

Welcome to NorthEast Monitoring’s Holter LX Analysis Software. Used in conjunction with a 
NorthEast Monitoring Digital Holter Recorder - either the DR180 Series, the DR180 Series with 
the optional OxyHolter cable, or the DR200/HE - LX Analysis allows you to fully review all of 
the ECG recorded during the Holter test, including all normal, ventricular, supraventricular, and 
paced beats. You can quickly review and edit morphology types, significant arrhythmic events, 
strips saved for the printed report, data trends, and tables. You can also review and edit report 
information before it’s printed, and then print whatever pages are required to document each 
patient’s Holter test. In addition, LX Analysis automatically reads recording data from the 
recorder’s flashcard - including entries made using the Event button - and saves sample strips of 
event markers and diary entries. Backup features, remote reporting, and spectral analysis are also 
included. Optional oximetry from the DR180 Series with OxyHolter and 12-lead data from the 
DR180 Series can also be analyzed, edited, and presented. 
Holter LX A
Note: This product, like all Holter monitoring products, should be used 
only under the direct supervision of a licensed physician.

NorthEast Monitoring - FDA Registered Establishment #1224919.

The Holter LX Analysis software - FDA 510K Market Approval Number 
K930564. 

Package contents
Your Holter LX Analysis package includes:

• NorthEast Monitoring Holter LX Analysis Software and manual CD

• NorthEast Monitoring License CD

• NorthEast Monitoring Software Protection Key with lanyard

• Card reader with USB cable.
nalysis                                                                                                                                                        1
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Recorder Definitions
The following definitions are applied 
throughout this manual: 

• "DR180 Series" is a DR180+ or 
DR181 recorder 

• "OxyHolter" is a DR180 Series 
recorder with an optional OxyHolter 
or OxyHolter/A cable

• "NEMon Holter" is any DR180 
Series or DR200/HE Holter recorder 

System requirements
Holter LX Analysis software must be 
used in conjunction with a NorthEast 
Monitoring Digital Holter Recorder - 
either the DR180 Series, the DR180 
Series OxyHolter, or the DR200/HE

To run the Holter LX Analysis soft-
ware, your personal computer must 
include:

• Microsoft Windows XP or Windows 
7 operating system

• a processor with a speed of 1 GHz 
or faster

• at least 1 GB of memory

• at least 10 GB of free space on your 
hard drive

• a monitor with a resolution of at 
least 1024 by 768

• a USB flashcard reader (included) or 
a laptop PC card slot

• a laser printer is recommended.

Operator knowledge
To use NorthEast Monitoring Holter 
LX Analysis Software, you must have 
extensive Holter knowledge that 
allows you to properly identify sinus 
and paced rhythms, abnormal rhythms, 
supraventricular and ventricular 
arrhythmias, artifact, ST segment 
changes, and pacemaker failures. In 
addition, all instructions assume a 
working knowledge of computers and, 
specifically a Windows operating sys-
tem.

Installation instructions
To run, Holter LX Analysis software 
must be installed on your hard drive. 
We recommend that no other programs 
be running when you install the soft-
ware. To install, follow these steps:

• Insert CD labeled Holter LX 
Analysis into your computer. 
Open “My Computer,” click on the 
drive, and you will now see a list of 
files that should be installed in 
order. Click on prompts where 
appropriate and let the system 
default during the installation and 
rebooting anytime it requests.

• Double-click on 1_SentinelInstall. 
This is the software that allows the 
system to recognize your software 
key. 

• Double-click on 2_AdobeReader.  
(If Adobe Reader already exists on 
your computer, you may want to 
skip this step.)

• Double-click on 3_Java_Install.  If 
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Launching LX Analysis
you are asked to reboot after Java 
installation, please reboot and 
continue with the next step.

• Double-click on 4_LXInstall.  This 
is the Holter LX Analysis appli-
cation. Each time you are prompted 
to go to the Next instruction 
window, press the Enter key to do 
so. On the last screen, make sure 
that the “Launch Holter LX 
Analysis” box is checked for instal-
lation to complete.  When you are 
prompted to select Finish, press the 
Enter key to do so. 

•  After a short delay, the Setup 
window opens. If you cannot see 
the Setup window, you should close 
the CD window for it to appear. 

• In the Setup window, enter appro-
priate information in each of the 
fields, including your Company 
name, the User’s name, and your 
preferred Language.   In the five 
fields for the Report Heading, enter 
up to five lines you want to appear at 
the top of the front page of each 

report. Update the Number of 
Patients as required (see Utilities for 
updating this number in the future). 
When the information is complete, 
click OK to close the Setup window. 
You can come back to this window 
at any time to update your data.

• If no License# was visible on the 
Setup window, remove the software 
CD and insert the License File CD 
on your computer. Open the CD 
directory and click on the License 
file. Follow the steps as prompted.

• Next, plug the software key into an 
available USB port on your 
computer and let the system install 
the software for it. 

Launching LX Analysis
Once the programs are installed, you 
start the LX Analysis software by 
selecting Programs > Holter LX Analy-
sis > LX Analysis from the Start menu. 

If you use the software often enough, 
Windows may add LX Analysis to the 
Start menu, and you can then start the 
software by selecting Start > LX Anal-
ysis.

LX Sleep Install
A special License# is required to view 
the LX Sleep Apnea software. If you 
have purchased the LX Sleep license, 
you will need to install LX Sleep on 
your desktop by installing the follow-
ing files that are also found on the CD:

• Double-click on 5_ 

Setup window
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Apnea_support_install and

• Double-click on 
6_Apnea_support_DLL

Now when you review a patient with 
oxymetry data, you will be able to uti-
lize the apnea features in the software.

Inserting the flashcard
ECG data recorded during the Holter 
period is saved on a removable flash-
card. The DR180+ Holter Recorders 
use a compact flashcard, while the 
DR200/HE and the DR181 Holter 
Recorders use an SD flashcard. To 
input the data from the card to the com-
puter system, first remove the flashcard 
from the recorder, and then insert it 
into your computer system’s card 
reader.

Into a USB compact flashcard 
reader

To insert the compact flashcard into 
the reader, hold onto the card by the 
edge with the ridge and insert the 
opposite edge into the opening of the 
flashcard slot. Push the card in gently 
until it is fully plugged in. Some card 
readers have a light indicating when a 
flashcard is properly inserted; if yours 
does, make sure the light comes on.

Into a USB SD flashcard reader

To insert an SD flashcard into the 
drive, hold the card right-side up, with 
the missing corner away from you and 
to the right. Insert the opposite edge 

into the opening of the card reader. 
Push the card in gently until it is fully 
plugged in. Some card readers have a 
light indicating when a flashcard is 
properly inserted; if yours does, make 
sure the light comes on.

Depending on your computer and your 
card reader, a window may appear 
acknowledging that a card has been 
newly inserted and listing what files 
are present on the card. A recording 
saved by a NorthEast Monitoring 
Recorder is named “flash.dat.” If the 
window appears, close it.

Into a laptop PC card slot

First insert the flashcard into a flash-
card adaptor; to do so, hold onto the 
card by the edge with the ridge and 
insert the opposite edge into the 
adapter. Then insert the adaptor, right 
side up into the laptop’s card slot. If a 
window appears listing what files are 
on the flashcard, close it.Formatting a 
flashcard for the first time 

To use a flashcard with a NorthEast 
Monitoring recorder, it must be format-
ted properly. Flashcards that come with 
the recorder are already formatted 
properly and need only to be initialized 
before first use. A card from a different 
source, though, must first be formatted 
using the FAT file system (not FAT 
32) and then initialized using North-
East’s software.
                                                                                                 Operator’s Manual
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Formatting a flashcard for the first time

Initialize
Formatting a flashcard 
for the first time
Flashcards not purchased from North-
East Monitoring must be formatted 
before they are used by the recorder. 

To format a flashcard, insert the card 
into your computer’s card reader, then 
select My Computer or with Vista 
select Programs > Accessories > Sys-
tem Tools > Computer. In the (My) 
Computer window, click on the icon 
designating your card reader, then 
select File > Format. When the window 
opens, set the File system to FAT, then 
click Start. Click Close when format-
ting is complete.

Initializing a flashcard 
To use a flashcard with a NorthEast 
Monitoring recorder, it must first be 
initialized using the LX Analysis soft-
ware. To do so, insert the card into the 
card reader, close the Explorer window 
that opens, and using the Holter soft-
ware, select File > Flashcard > Initial-

ize. The Initialize Flashcard window 
opens. 

First determine that the correct drive 
has been selected for your card. The 
check box should be populated, and if 
there are more than one cards in the 
reader, it should be highlighted in blue. 
If drive has not been found, check to be 
sure that a card is in the slot and the 
reader is attached to the reader. You 
will need to Exit and return to this 
screen to refresh the Drive list.

Once your drive has been found with 
the card, you should now select the 
appropriate Type of Analysis/Report 
that corresponds to the patient to be 
hooked up. It will be highlighted in 
blue.

Lastly, check to make sure that the cor-
rect card format option is selected - the 
corrected recorder should be selected 
and the appropriate format should be 
chosen. If you are sure that your 3-
channel DR181 or DR200/HE record-
ing will be less than 48 hours, you can 
select that option. 

Now press Erase and your card will be 
initialized for its next use.

Note: If you insert a card into the 
recorder and get a message that the 
“Flashcard is missing,” the card is 
not formatted or erased properly.

 Flashcard Window
LX Analysis                                                                                                                                                 5
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The Holter procedure
NorthEast Monitoring Holter LX Anal-
ysis software is used in conjunction 
with data from a NEMon Holter 
Recorder. After a patient has worn the 
recorder, you should remove the card 
from the recorder and insert the card in 
your computer system’s card reader 
and the Holter signal will be loaded 
onto your system. While the signal is 
being transferred, the software pro-
cesses it, then you review the results, 
edit as needed, and print the report.

An overview of the process is covered 
in this chapter, and details are covered 
in subsequent chapters.

The Holter procedure typically 
includes the following steps:

• Holter the patient using a NEMon 
Holter recorder.

• Remove the recorder from the 
patient and remove the flashcard 
from the recorder.

• Insert the flashcard into the 
computer’s card reader.

• Start the Holter LX Analysis 
software.

• Enter/review information about the 
patient and the recording.

• Let the software analyze the Holter 
data.

• Review the templates in the Bin 
display to ensure that each type of 
beat is identified properly. Edit bins, 
templates, or beats as necessary. 
Make measurements as necessary. 

(Bin feature not available in 
Enhanced Level.)

• Review what Critical Events were 
found throughout the recording. 
Save strips to document additional 
significant events for the final 
report.

• Review the Saved Strips, making 
sure that all significant events are 
documented and labeled properly.

• Type your comments about the 
Holter test in the Report Summary.

• Create and print the final report to 
be reviewed by a physician.

Detailed information about the steps 
outlined above appears in subsequent 
chapters in this manual.

Online help
In addition to the information in this 
manual and the on-screen help mes-
sages that appear within the LX Analy-
sis software, more information and 
help is available at our web site at 
www.nemon.com.

Our “Technical Support” page includes 
Frequently Asked Questions and con-
tact information.

The most current version of this man-
ual and our software can always be 
found on our web-site on the “Down-
loads & Documents” page.
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2  PATIENT 
INFORMATION

The Patient Information window contains important information about the patient who wore the 
Holter recorder. The Holter LX Analysis software automatically retrieves recording data from the 
recorder’s flashcard, along with the Holter signal, but you are responsible for entering the remain-
ing data. The data saved by the recorder includes an identification number, the recorder number, 
the date, the start time, and whenever the patient pressed the Event button. 
Holter LX Analy
While running the LX Analysis software, you have the choice of 
opening the Patient Information window for (1) the last patient 
whose Holter test was accessed (that is, the “current” patient),       
(2) a previous patient whose Holter test has already been analyzed, 
or (3) a new patient whose Holter test has not yet been analyzed. In 
the first two cases, a patient record has already been created for the 
patient and the Holter data for the patient has already been down-
loaded from the flashcard onto the hard drive of your computer. In 
the case of a new patient, a new Patient Information record must be 
created and the Holter information downloaded from the flashcard. 
This chapter covers creating a new patient record first.

Entering information for a new patient
To enter information about a new patient’s Holter recording, the 
LX Analysis software must be running. When the program appears, 
it displays a blank screen with the standard toolbars. 

To start a new patient, first insert the patient’s flashcard into the 
card reader and then select File > New.

Standard Holter toolbars
sis     7
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New Pa
Example of radio button

tient Information window

If you select File > New before insert-
ing the card, you will see a Confirm 
window that explains that there is no 
flashcard in the drive. If this happens, 
insert the flashcard into the drive and 
click Retry.

Note: If you see a message that says, 
“There are no empty patient...” 
instead of the New Patient window, 
see “Making room for new patients” 
in Chapter 9: Managing Patient 
Reports.

When the Patient Information window 
opens for a new patient, the data on the 
flashcard is immediately read from the 
card reader. As the Holter data from 
the card loads onto your computer hard 
drive, you can start entering or editing 
patient information.

Note: Once the flash.dat has loaded, 
the “Copy flashcard” button in the 
Patient Information window changes 
to “Copy different flashcard.” If the 

patient information displayed does 
not match the correct patient, remove 
the card, insert the correct one and 
click “Copy different flashcard.”

Type the patient name using the Last 
name, First name, and Middle initial 
(MI) fields. Use your cursor or the Tab 
key to move to the next field. The 
name in the printed report appears as 
entered in this window. 

Using your cursor or Tab key to move 
around the screen, fill in any of the 
remaining data fields. There are six 
types of data fields:

• Freeform: These allow you to type 
alphanumeric characters, limited by 
the space constraints displayed, e.g., 
patient name.

• Radio buttons: The Sex entry 
appears as this type. Circles repre-
sent the two choices. Click on a cir-
cle to select it. Only one choice can 
be selected.

• Formatted: The entry 
must be in a specific for-
mat. For example, the 
D.O.B. (date of birth) 
field must be entered with 
a valid date format; which 
one depends on the set-
tings of your system. If 
the D.O.B. field reads 
MM/DD/YYYY, the 
                                                                                                   Operator’s Manual
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Entering information for a new patient
entry must be typed with the first 
two digits representing the month, 
the second two digits representing 
the day, and the final four digits rep-
resenting the year. If the D.O.B. 
field reads DD-MON-YYYY, the 
entry must be typed with two digits 
representing the day, three letters 
representing the abbreviation for the 
month, and four digits representing 
the year. (To change the date for-
mat, see Chapter 8: Preferences.)

• Automatic: These are filled in auto-
matically from the flashcard. 

• Check box: The fields with an 
empty square can be clicked on to 
display a check mark. Click again to 
remove the mark.

• Combination: In these, you can 
either type a freeform entry or make 
a selection from a predetermined list 
of choices. To display the list of 
choices, click on the scroll arrow to 
the right of the field. In the Indica-
tion and Medication fields, the scroll 
arrow does not appear until you 
click on the field itself. To select a 
choice from the list, click on it.

Some combination boxes have an 
auto-fill feature. When you start typ-
ing an entry, the software will auto-
matically finish typing for you from 
its list of choices; if the word taken 
from its list is incorrect, simply keep 
typing until the correct one appears. 
If the correct one is not on the list, 
type the complete entry. These fields 
have the auto-fill feature: Indication, 

Medication, Physician, Interpreting 
physician, and Strip label.

DOB and Age

The D.O.B. and Age fields work 
together. If you know the patient’s date 
of birth, enter it, and the software auto-
matically calculates the patient’s age 
based on the D.O.B. and the recording 
date. If you do not know the date of 
birth, but know the age, type a numeric 
entry in the Age field, and select the 
appropriate unit (e.g., years) in the Age 
Unit field. If you know neither, leave 
the fields blank. The software does not 
allow an inconsistent D.O.B. and age; 
if you enter inconsistent data, it will 
leave the age and remove the D.O.B.

Type of Analysis/Report

Your system has been set up with five 
different configurations or Type of 
Analysis/Reports to get you started. 
After you save a patient with one Type 
of Analysis/Report, you can change it, 
but all data that you edited, except for 
patient information, will be lost. The 
initial types that are available are visi-
ble on the drop-down menu: 

Type of Analysis/Report
LX Analysis - Pro  9
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Six
Note: For more information about 
Types of Analysis/Report, see Chapter 
10: Configurations.

Notes

The Notes field allows an alphanu-
meric entry that can be used to record 
information that might be helpful about 
the Holter test or the patient. It is not 
printed on the final report. To enter 
notes to be printed in the final report, 
use the Comments section of the 
Report summary.

BMI

Holter LX Analysis will calculate your 
patient’s Body Mass Index (BMI) if 
you enter the patient’s height and 
weight and the appropriate units. A 
patient’s weight status can be deter-
mined from the BMI as follows: 

• Below 18.5 - Underweight

• 18.5 -24.9 - Normal

• 25 - 29.9 - Overweight

• 30 & Above - Obese
 

6-Minute Walk 
Assessment Window
If you have a 6-Minute Walk Assess-
ment patient, you are able to enter 
6MWA data using the window that is 
accessible at the bottom of the Patient 
Information Screen. The 6MWA win-
dow allows you to enter data that was 
recorded during the assessment. This 

BMI on Patient Information Screen

-Minute Walk Assessment Window
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Entering diary information

Dairy 
data can be output by using the 6MWA 
front page that is available on the 
Reports screen.

Entering diary 
information
While wearing the Holter recorder, the 
patient can identify symptoms and 
activities in two ways:

(1) by pressing the Event button on the 
recorder and, possibly, entering a pre-
coded symptom or activity, or 

(2) by keeping a written record of times 
and symptoms or activities. 

When analysis takes place, the soft-
ware reads the Event button informa-
tion directly from the flashcard and 
enters it automatically. You must type 
any significant information from the 
written record manually into the Diary 
Symptoms window.

To open the Diary Symptoms window, 
click the Diary button in the Patient 
Information window. The Diary Symp-

toms window contains two types of 
fields: time and symptom. Any entries 
that are already present when you first 
open a patient’s Diary Symptoms win-
dow were those automatically read 
from the flashcard.

Enter the time and symptom for each 
diary event recorded.

Note: Whether the software uses a 
12- or 24-hour clock is determined by 
your computer’s setting in the Control 
Panel.

Diary Time 

To enter the time of a written symptom 
or activity, click on the text in the time 
field. Type over the existing characters, 
using the format indicated, with either 
a 12- or 24-hour clock:

• HH stands for a two-digit hour.

• MM stands for a two-digit minute.

• 00 stands for a two-digit second; 
this is automatically filled in with 00 
so that you do not have to type the 
seconds.

• using a 12-hour clock format, am 
stands for the morning and pm 
stands for the afternoon; change the 
“a” to “p” if necessary.

• 01 at the end indicates Day 1; 
change to 02 - 15, where appropri-
ate.

Symptom

To enter a symptom, first click on the 
Symptom field next to the appropriate 
time-of-day. Then enter the text either 

symptoms window
LX Analysis - Pro  11
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by typing a freeform entry or by click-
ing on the arrow to display a scrolling 
list of pre-typed entries. To enter a 
selection from the list, click on it; the 
list window closes and the entry 
appears in the Symptom field. You can 
also add freeform information after 
selecting a pre-typed entry. To do so, 
make your selection, then click at the 
end of the text and type the additional 
information, followed by the Enter 
key.

To delete a diary entry, click to high-
light the time-of-day of the entry and 
then click the Delete button. The time-
of-day will revert to HH:MM:00-01 or 
HH:MM:00am01and no entry will be 
saved. To select multiple entries to be 
deleted, select one and then hold the 
Shift key down while you select subse-
quent entries; when all entries that you 
want deleted are highlighted, click 
Delete.

When you have finished entering all 
written diary events, click the Done 
button to save your entries and return 
to the Patient Information window.

Changing Settings
During Holter analysis, the LX Anal-
ysis software makes decisions about 
the Holter signal based on a variety of 
pre-defined settings from the Type of 
Analysis/Report or Configuration you 
have chosen for your patient. After 
selecting a configuration, you can 
change any of the analysis criteria in 
the Settings windows, which are acces-

sible from the menu displayed by 
clicking the Settings button in the 
Patient Information window or by 
clicking the Settings menu item in the 
main tool bar.

Adjustments that can be made in the 
Settings windows are detailed in Chap-
ter 3: Holter Analysis.

Starting Holter analysis
To start Holter analysis after entering 
patient data, click the Start button at 
the bottom of the Patient Information 
window. The Analysis window 
appears. When analysis is complete, 
the Analysis window closes automati-
cally. 

To interrupt analysis, click the Stop 
button. The analysis ends immediately, 
with data only for the portion that was 
complete. The unanalyzed ECG can be 
reviewed in Page and printed in full 
disclosure. Details of the Holter analy-

Analysis window
                                                                                                   Operator’s Manual



Holter 

Editing patient information for the “current” patient

Patient Informatio
sis process are presented in Chapter 3: 
Holter Analysis.

Editing patient 
information for the 
“current” patient 
Once analysis is completed for a 
patient’s Holter data, you can re-open 
the Patient Information window and 
edit the information. To open the 
Patient Information window for the 
current patient, select File > Patient 
Information. 

While most of the Patient Information 
window is the same as that of a new 
patient, there are significant differ-
ences: 

• The addition of the Status button 
(see the “Status window” section 
below for details).

• The Re-analyze button replaces the 
Start button because the Holter sig-

nal has already been analyzed. (See 
Chapter 3: Holter Analysis, for 
information about using the Re-ana-
lyze button.)

• The absence of the Copy different 
flashcard button. To copy the Holter 
data from a flashcard, you must use 
File > New.

Note: If you choose to change the 
Type of Analysis/Report at this time, 
you will be forced to redo analysis and 
all edited ECG data will be lost. 

Status window

After a patient’s Holter signal has been 
analyzed, the Patient Information win-
dow also includes a Status button that 
opens the Status window. The Status 
window helps you keep track of the 
status of each patient’s Holter test. As 
you complete each step, you can click 
on the check box next to each field in 
the Status window to indicate that the 
step has been completed. 

The Status fields include:

Status window

n window for analyzed (not new) patient
LX Analysis - Pro  13
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• Edited indicates that the Holter sig-
nal was reviewed and edited as 
needed

• Printed means the report was 
printed

• Verified means the report was 
reviewed and approved by a quali-
fied physician

• Locked removes all editing capabil-
ities from the Patient Information 
and Review windows. No changes 
are allowed.

In addition, one other Status field 
appears - Backup. That field is filled in 
automatically when you use the 
Backup program to save a patient’s 
Holter information; it contains either 
“Full” to indicate that all Holter data is 
backed up with the patient report or 
“Report” to indicate that just the com-
piled report is backed up for this 
patient.

Closing the Patient Information 
window

To save your data and close the Patient 
Information window without starting 
analysis, click OK. To close it without 
saving any changes, click Cancel.

The Current Patient

At any one time, only one patient is the 
current patient - the patient whose 
information appears when you select 
File > Patient Information, the patient 
whose ECG appears in the screen dis-
plays, the patient whose report prints 
when you make the request. To change 

the current patient to a different one, 
either click on the appropriate name on 
the Patient Open list and click Open, or 
double-click on the appropriate line.

Also, you can change the current 
patient using the << and >> buttons in 
the bottom of the Holter LX window. 
<< changes the current patient to the 
previous one on the patient list and    
>> changes the current patient to the 
next one on the patient list. Click each 
button repeatedly to move backward or 
forward through the list. To display a 
combo box listing all patients on the 
system, click the arrow to the left of the 
<< and >> buttons.

For more information about managing 
and backing up the patient records 
saved on the system, see Chapter 9: 
Managing Patient Reports.
                                                                                                   Operator’s Manual



Holter 

Navigating the patient list
Navigating the patient 
list
You can keep multiple patient Holter 
recordings and reports on your com-
puter system. All of the patients cur-
rently saved in the software appear 
when you select File > Open from the 
toolbar. 

The list of patients in the Open Patient 
window includes information regard-
ing each report. Although the particular 
fields are customizable in the Backup 
program, the fields included in the 
standard release of the LX Analysis 
software are not. The sortable columns 
that appear for each patient are:

• No. - Patient Number

• Directory - Where the patient record 
stored on the system

• Name - of patient

• Type of Analysis/Report - the con-
figuration that was used to analyze 
the patient

• ID# of patient

• Analyzed - date of recording

• Length - time analyzed

• E, P, V, L - from Status window. 

• HIS - Hospital Information System

• Backup - checked when patient has 
been backed up.

HIS Export (Pro level only)

You are able to export records for your 
Hospital Information System. This is 
done by selecting a patient and press-
ing the HIS Export button. By doing 
this a record will be written to the 
directory c:\HIS_Transfer. 

An example of the Open Patient window
LX Analysis - Pro  15
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Remote Open Patient window

Backup

This will take you to the Backup sys-
tem where you can select one or more 
patients to be backed up.

Delete

This will allow you to delete one or 
more patients. This data will be lost 
forever unless saved or Backed-up 
elsewhere.

Receiving Patients 
Remotely (Pro and 
Enhanced Plus levels 
only)
You are able to receive and analyze 
flash.dat files sent from other facilities. 
For more information on sending 

patient files see Chapter 12 - Remote 
Send. 

In order to enter patient files into LX 
Analysis, you will need to go to File > 
Open and press the Remote button at 
the bottom of the screen. You will now 
see the Remote Open Patient window. 

The Remote Open Patient window has 
two sections - the top section lists all of 
the patients that are currently in LX 
Analysis, the bottom section lists all of 
the patients who currently exist in the 
FTP directory which is usually set up 
as c:\nm\ftp. If you save your incoming 
records in a different directory, you 
should enter that now and press the 
Refresh button at the bottom of the 
screen.

You can copy a patient file onto LX 
Analysis by: 
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Previewing the data on the flashcard
1. Select a blank patient# at the top of 
the screen by clicking on it

2. Select the incoming patient at the 
bottom of the screen

3. Press the Copy button in the middle 
of the screen. The patient should 
now be copied to LX Analysis and 
the patient identification informa-
tion will now appear in the top and 
has been loaded into LX Analysis. 

4. Close the screen and you will now 
see the Patient Information record 
for the patient. You can now analyze 
as you would any other patient.

Other buttons on the screen are:

• The FTP delete button in the mid-
dle of the screen is used to delete 
FTP records (displayed on the bot-
tom) after they have been copied 
into LX Analysis.

• The Backup button is used to open 
the Backup functionality.   This fea-
ture is also available via the Utilities 
screen and more information can be 
found in Chapter 9 - Managing 
Patient Reports.

• The Delete button is used to delete 
patient records from LX Analysis. 
Only do this if the patient has 
already been backed up, or you no 
longer need this patient information.

• The Open button will open the 
patient# selected at the top in LX 
Analysis. 

• The Cancel button will return you 
to the previous screen.

Previewing the data on 
the flashcard

If you would like to review the clerical 
information on a flashcard before cre-
ating a new patient record, you can 
insert the card into the drive and then 
select File > Preview from the main 
toolbar. This opens the Preview win-
dow, which displays the identification 
and recorder numbers, along with the 
date recorded and the start time, 
directly off the card without loading 
the information onto your computer’s 
hard drive. Use this feature to verify 
which flashcard contains a particular 
patient’s Holter data. 

After verifying that the card is the cor-
rect one, click OK to close the window, 
select File > New and follow the nor-
mal procedure described at the begin-
ning of this chapter.

If the information in the Preview win-
dow does not match the information 
you have, do not proceed without 
clearing up the discrepancy. 
LX Analysis - Pro  17
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3 HOLTER ANALYSIS
During analysis, the Holter LX Analysis software detects each R-wave; determines the patient’s 
normal morphology; establishes normal, ventricular and paced templates; matches every beat to a 
template; counts normal, supraventricular, ventricular and paced beats, including any pairs and 
runs; measures RR intervals and calculates heart rates; does ST segment analysis; counts other 
abnormalities as defined in the Scanning Criteria; and saves sample strips for the final report. You 
can review and edit decisions made by the software; the information is then either re-analyzed or 
updated to include your changes. This chapter addresses the features that you have control over 
during analysis, re-analysis and updating.
Holter LX Analy

indow
Starting Holter analysis

To start Holter analysis 
for a new patient, you 
must have the correct 
patient’s flashcard in the 
card reader before select-
ing Patient > New. After 
you have entered the 
patient information (see 
Chapter 2: Patient Infor-
mation for details about 
data entry), click the 
green Start button at the 
bottom of the Patient Information window to start Holter analysis. 
The Analysis window appears. When analysis is complete, the 
Analysis window closes automatically. 

To interrupt analysis, click the Stop button. The analysis ends 
immediately, with data only for the portion that was analyzed by the 
time of the interruption. The unanalyzed ECG can be reviewed in 
Page and printed in full disclosure.

Analysis w
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level)
 What Strips to Auto Save window in Settings menu (Pro 

Arrhythmia analysis
Certain analysis and related documen-
tation criteria are already set when you 
click the Start button on the Patient 
Information window. They include all 
the settings that appear in the five win-
dows that are accessible using the Set-
tings button in either the Patient 
Information window or on the main 
Holter toolbar. Those windows are 
What Strips to Auto Save, How Often 
Strips Auto Save, Scanning Criteria, 
Spectral Analysis, and Oximetry.

What Strips to Auto Save

All the different types of labels the 
software uses appear in this window. 
The software uses these labels to iden-
tify one particular beat or event (for 
example, the “current” beat or the beat 
centered in a Saved Strip). Each label 
can be turned off or on to indicate 
whether sample strips of that type 
should be saved for the final report. A 
check mark indicates that 
sample strips with that 
label will be saved. 

Click on a label or its 
check box to turn it off or 
on. Click on the button 
Select/Deselect All to turn 
all labels on or off. Click 
OK to save changes and 
close the window, and 
click Cancel to close the 
window without saving 
changes.

The Pro level of software 
has all of the labels listed 
below. The Enhanced ver-

sions of the software have a reduced 
number of strip labels.

The labels in the What Strips to Auto 
Save window are defined as:

• VPB - a beat that matches a ventric-
ular template, regardless of prema-
turity

• VPB pair - two VPBs in a row

• VTAC - three or more VPBs in a 
row, regardless of heart rate

• Early VPB - a VPB that is at least 
as early as the VPB prematurity set-
ting in the Scanning Criteria win-
dow

• R on T - a VPB that occurs early 
enough to perhaps fall on the T-
wave of the preceding beat; for 
details, see the algorithm explana-
tion in Appendix B

• Bigeminy - an alternating pattern of 
single VPBs and normal beats, with 
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Arrhythmia analysis

)

at least three VPBs in 
the series; that is - V, 
N, V, N, V, N

• Trigeminy - a pat-
tern of single VPBs 
every third beat, with 
normals in between, 
with at least three 
VPBs in the series; 
that is - V, N, N, V, 
N, N, V, N

• Quadrigeminy - a 
pattern of single 
VPBs every fourth 
beat, with normals in 
between, with at least three VPBs in 
the series; that is - V, N, N, N, V, N, 
N, N, V, N

•  Longest VTAC - the longest run of 
three or more VPBs, regardless of 
rate

• Fastest VTAC - the run of three or 
more VPBs with the fastest heart 
rate

• Failure to capture - the presence of 
a pacemaker spike without a follow-
ing R-wave

• Failure to sense - the occurrence of 
a paced beat too soon following 
another beat; that is, too short an RR 
interval

• Inhibition - the absence of a paced 
beat when it should occur; that is, 
too long an RR interval

Note: Please refer to the section 
“Pacemaker analysis” in this chapter 
for more information about the 
pacemaker labels listed above.

• SVPB - a beat that matches a nor-
mal template, but occurs at least as 

early as the SVPB prematurity set-
ting in the Scanning Criteria win-
dow

• SVPB pair - two SVPBs in a row

• SVT - three or more SVPBs in a 
row, regardless of heart rate

• Longest SVT - the longest run of 
three or more SVPBs, regardless of 
rate

• Fastest SVT - the run of three or 
more SVPBs with the fastest heart 
rate

• Depression - at least a 1 millimeter 
depression in the ST segment com-
pared to the patient’s normal

• Elevation - at least a 1 millimeter 
elevation in the ST segment com-
pared to the patient’s normal

Note: The Depression and Elevation 
settings here are NOT strip labels. 
Instead, they determine whether strips 
of the following types are saved for 
each episode of ST Depression or 
Elevation detected by the software.

 What Strips to Auto Save window in Settings menu (Enhanced levels
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• Baseline - a sample of the patient’s 
normal ST segment preceding a 
detected event

• Onset - near the beginning of a 
detected event, at the time the 
change is 0.5 mm.

• Maximum HR - the ECG when the 
maximum heart rate occurred during 
the event

• Maximum deviation - the ECG at 
the point of maximum change from 
the normal

• End - the ECG after the patient has 
re-established normal

Note: Please refer to the section “ST 
Segment Analysis” in this chapter for 
more information about the ST labels 
listed above.

• Pause - an RR interval at least as 
long as the Pause length in the Scan-
ning Criteria window

• Tachycardia - a heart rate at least as 
fast as the Tachycardia setting in the 
Scanning Criteria window

• Bradycardia - a heart rate at or 
below the Bradycardia setting in the 
Scanning Criteria window

• Irregular RR - a pattern of RR 
intervals (between normal beats) 
that falls outside the variation that is 
considered normal, but without RR 
intervals early enough to be called 
SVPBs

• Minimum HR - the minimum heart 
rate calculated using the heart rate 
algorithm described in Appendix B, 
generally a four-beat running aver-
age

• Maximum HR - the maximum 
heart rate calculated using the heart 

rate algorithm described in Appen-
dix B, generally a four-beat running 
average

• Shortest RR - the shortest RR inter-
val measured during the Holter 
period, excluding those before or 
after artifact

• Longest RR - the longest RR inter-
val measured during the Holter 
period, excluding those before or 
after artifact

• Diary or event - a strip at the time-
of-day when either (1) the event but-
ton was pushed or (2) an entry was 
manually typed into the Diary 
Symptoms window

• Save 1 strip/hour - a strip at the 
onset of each new hour

• Calibration strip - the calibration 
signal at the onset of the Holter 
recording

How Often Strips Auto Save

These settings control the distribution 
of strips that are saved for the report. 
The Pro level of software has all of the 
options listed below; the Enhanced ver-
sions of the software have a reduced 
number of options.

They have the following uses:

• Maximum number of arrhythmia 
strips: Saved strips fall into two 
types - arrhythmia and ST. You can 
limit how many arrhythmia strips 
are saved for the final report by 
adjusting this field.

• Maximum number of ST events 
documented: Each ST event, 
regardless of whether it is depres-
sion or elevation, can have five 
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strips saved to document it. To 
reduce the number of events for 
which strips are saved, enter a 
smaller number in this field. To 
change how many strips are 
saved per ST event, make the 
change in the What Strips to 
Auto Save window.

• Maximum number of strips 
per interval: Interval length 
within the Holter period is 
defined in the Scanning Criteria 
window, but here you can control 
the upper limit of how many 
arrhythmia strips are saved within 
each interval.

• Maximum strips per interval of 
the same name:  You can limit the 
number of arrhythmia strips of the 
same label that are saved within an 
interval.

• Maximum strips of the same 
name:  You can limit the number of 
arrhythmia strips of the same label 
that are saved during the entire 
Holter period.

• Minimum time (minutes) between 
strips of the same name: You can 

re-distribute the arrhyth-
mia strips saved by 
requiring more or less 
time between those with 
the same label.

• Maximum number of 
alternative strips: 
Eight strip labels are 
associated with alterna-
tive strips in the Saved 
Strips window - Mini-
mum HR, Maximum 
HR, Shortest RR, Long-
est RR, Longest VTAC, 

Fastest VTAC, Longest SVT and 

Fastest SVT. Here you can control 
how many alternative selections you 
have for those labels. 

To make changes, select the current 
entry and type over it. Click on OK to 
save changes and exit; click Cancel to 
close without saving.

How Often Strips Auto Save window in Settings menu (Pro level)

How Often Strips Auto Save window in Settings menu
 (Enhanced levels)
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Scanning Cri
Scanning Criteria

The Scanning Criteria are used during 
Holter analysis to define some of the 
arrhythmias labeled by the software, 
along with settings that control the 
amount of information processed. The 
Scanning Criteria window is shown on 
the following page. The adjustable cri-
teria include:

• Tachycardia defines at least how 
fast a heart rate must be for the 
Tachycardia label to appear. All 
beats that occur at that heart rate or 
above are included in the tachycar-

dia beat count in the Tachy/Brady 
table in the Tables window.

• Bradycardia defines how low the 
heart rate must be for the Bradycar-
dia label to appear. All beats that 
occur at that heart rate or below are 
included in the bradycardia beat 
count in the Tachy/Brady table in 
the Tables window.

• SVT defines the heart rate that sepa-
rates fast and slow runs of SVPBs 
that appear in the Supraventricular 
Runs table of the Tables window 
and in the Report Summary. In all 
other areas of the software, slow and 

teria window in Settings menu (Pro level)
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fast supraventricular runs are com-
bined in the SVT counts.

• VTAC defines the heart rate that 
separates fast and slow runs of 
VPBs that appear in the Ventricular 
Runs table of the Tables window 
and in the Report Summary. In all 
other areas of the software, slow and 
fast ventricular runs are combined in 
the VTAC counts.

• Pause length (sec.) defines how 
long an RR interval must be for the 
beat at its onset to be called a Pause 
and appear white on the colored dis-
play. This RR interval can be initi-
ated by any type of beat except 
artifact.

• Count Irregular HR as Afib will 
relabel Irregular R-R as Afib on the 
Trends and in reporting. Use it when 
the patient exhibits atrial fibrillation 

or any other time the SVPB count is 
not appropriate.

• Signal quality has three settings 
that control the amount of artifact 
that is tolerated before the signal is 
thrown out because of too much 
artifact: 

1. Research turns off the artifact detec-
tor so that none of the signal except 
the first minute and the last minute 
of the recording is called artifact. 
This results in the analysis of all the 
signal, including any artifact.

2. Excellent allows the software to 
detect and reject a moderate amount 
of artifact. Any signal that is deter-
mined to be contaminated with arti-
fact appears light blue and is not 
analyzed. Anything that occurs dur-
ing periods of artifact is not counted.

Scanning Criteria window in Settings menu (Enhanced levels)
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3. Normal allows the software to dis-
card any signal that it considers con-
taminated by artifact. Anything that 
occurs during periods of artifact is 
not counted.

• Number of channels processed 
determines whether the software 
uses one or two channels to deter-
mine the location of an R-wave and 
what template each matches. Single-
channel analysis uses just the chan-
nel set in the Primary channel field. 
Dual-channel analysis uses the Pri-
mary channel to locate R-waves 
first, then refers to the Alternate 
channel as a back-up channel to 
locate R-waves, and both primary 
and alternate to do template-match-
ing.

• Primary channel determines which 
channel is used during analysis. For 
single-channel analysis, the primary 
one is the only one used to locate R-
waves and do template-matching. 
For dual-channel analysis, the pri-
mary channel is used first to locate 
R-waves, but if an R-wave cannot 
be located, the software refers to the 
alternate channel to locate the beat, 
if one is present.

• Alternate channel is used only in 
two-channel processing. It deter-
mines which channel is used in case 
an R-wave is not found in the pri-
mary channel, and it controls which 
channel is used as a second channel 
for template-matching.

• Automatic channel selection 
allows the software to switch pri-
mary and alternate channels if it 
determines that signal has been lost 
in the primary channel. Turn this off 

to force the software to use a partic-
ular primary or alternate channel. If 
you change the Number of channels 
processed field to 1, this setting is 
turned off automatically.

• Automatic ST Marker selection 
allows the software to detect the j-
point and set up the ST markers 
appropriately. If you manually 
change the ST marker locations in 
the Calibration window, this setting 
will turn off automatically.

• Process ST events lets you turn ST 
segment analysis on or off, depend-
ing on your preference.

• Label events as artifact lets you to 
include or exclude events from the 
recorder from being labeled as arti-
fact. Sometimes events are inappro-
priately labeled as arrhythmia 
because of the calibration mark that 
is saved at the time the button is 
pressed.

• Lead Labels allows you to change 
the reporting label for each channel. 
You can also enter a label of your 
own by typing in a new entry.

• Narrow QRS permits the software 
to identify narrower-than-normal 
QRS complexes, like those seen in 
pediatric patients, as normal beats. 
Turn this on routinely for pediatric 
patients.

• Artifact filter works in conjunction 
with the Signal quality setting. If it 
is turned on and Signal quality is set 
to Normal, the filter limits the 
response to 20 Hz, instead of 70. If 
it is on and the Signal quality is set 
to Excellent or Research, the filter 
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limits the response to 30 Hz instead 
of 70.

• QTc Calculation lets you choose 
which formula to use for QTc calcu-
lation. The formulae are as follows:

1. Bazett: QT/(RR^(1/2))

2. Hodges: QT + 1.75*(60/RR - 60)

3. Framingham: QT + 0.154*(1-RR)

4. Frederica: QT/(RR^(1/3))

• Interval size (min.) determines how 
many minutes are including in each 
interval in the interval tables of the 
Tables window. 

• Analysis duration determines how 
many hours of data are analyzed. All 
the ECG loads in from the memory/ 
flashcard during analysis, but analy-
sis stops after the amount of time 
indicated here. It uses the HHH:MM 
format, with the first three digits 
indicating how many hours and the 
second two indicating how many 
minutes. A maximum of 336 hours 
(14 days) may be entered.

• Extra dead-time controls the tail 
end of the dead-time period follow-
ing an R-wave during which another 
QRS complex cannot be detected, 
allowing for the presence of a T-
wave. Increase the time (in seconds) 
if large T-waves are being identified 
as R-waves, and decrease the time if 
early beats are being missed. See 
details in Appendix B.

• SVPB prematurity (percent) sets 
the requirement for how early a beat 
that matches a normal (or aberrant) 
template must be for it to be identi-
fied as an SVPB. For example, at a 
heart rate of 60 beats per minute, a 
normal RR interval is 1 second long, 

and a beat that is 10 percent prema-
ture would fall at 0.9 seconds after 
the preceding beat. A properly timed 
beat would be 0 percent premature, 
that is, not early.

• VPB prematurity (percent) sets the 
requirement for how early a beat 
that matches a ventricular template 
must be for it to be identified as an 
early VPB. All matches to ventricu-
lar templates are identified as VPBs, 
but those that are especially early 
can be counted separately as early 
VPBs.

• Pacemaker type contains four set-
tings that allow the software to 
expect certain behavior:

• Not paced means that the software 
will not identify any pacemaker 
spikes, beats or failures.

5. VVI means that each paced beat will 
be preceded by a single spike. All 
paced beats are counted as ventricu-
lar paced.

6. AV sequential means that paced 
beats will be preceded by two pace-
maker spikes, one atrial and one 
ventricular. All paced beats are 
counted as AV paced.

7. DDD means that paced beats can be 
preceded by either one or two pace-
maker spikes. Depending on the 
spike’s location relative to the fol-
lowing R-wave, a beat preceded by 
a single spike can be called either 
atrial paced or ventricular paced, 
while a beat preceded by two spikes 
can be counted as AV paced. 

• Minimum heart rate refers to the 
minimum rate allowed by the pace-
maker. If the pacemaker does not 
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fire appropriately and there is an RR 
interval longer than the patient 
should experience, the Inhibition 
label appears.

• Maximum heart rate refers to the 
maximum rate initiated by the pace-
maker. If the pacemaker fires early, 
typically because it did not sense the 
previous beat, it would result in a 
faster rate, the Sense failure label 
appears.

• Maximum vent. spike to R inter-
val sets the maximum time between 
the firing of the second pacemaker 
spike and the following R-wave. If 
the second spike appears and is not 
followed by an R-wave in this 
amount of time, the Capture failure 
label appears.

• Maximum atrial spike to R inter-
val sets the limit for how long is 
allowed between a single spike and 
the subsequent R-wave. If a single 
spike occurs and the following R-
wave is not within this amount of 
time, the Capture failure label 
appears.

• Paced beat and the beat after can 
be called a SVPB is a setting that 
allows you to identify early beats 
following a paced beat as SVPBs 
because they are premature. 

Note: Please refer to the section 
“Pacemaker analysis” in this chapter 
for more information about the 
pacemaker settings listed above.

Re-analysis
If you have already analyzed the 
patient’s Holter test, changes that you 
make to some of the settings may force 
the software to re-analyze the patient’s 
data, while others require an update to 
take effect. 

Because changes in some of the set-
tings have such a fundamental effect on 
the data, the analysis step is repeated 
using the new settings. That step is 
called re-analysis. Re-analysis is 
required after changing any of the set-
tings in the Processing criteria, Pace-
maker criteria and Processing modes, 
as well as Analysis duration or Extra 
dead-time. After making a change to 
any of these settings and clicking on 
OK to close the window, the software 
asks you to confirm that you want the 
data re-analyzed or not. If you want the 
change to take effect, click Yes. If not, 
click No, and your changes to Settings 
will not be saved.

Although re-analysis itself takes a brief 
amount of time (the same as analysis), 
the patient will be newly analyzed 
again and all editing changes you have 
made previously will be lost.

Confirm window asking whether to re-analyze
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w

Note: Because re-analysis is required 
after a change in some Settings, be 
sure to make any changes to the 
Settings before you work on the final 
report. Any bin, template or beat 
editing, along with manually saved 
sample strips and typed comments will 
be lost after some changes in the 
Settings.

Update
Some changes in the Settings require 
an update afterward, just as beat, tem-
plate and bin editing (in Enhanced Plus 
and Pro) and single-beat and all-
matches editing in Page require an 
update afterward. The update incorpo-
rates simple changes into all other 
aspects of the report. For example, a 
change in all matches to a beat with 12 
matches from ventricular to aberrant 
will affect other aspects of the report: 
the total count of VPBs will decrease 

by 12 and SVPBs will increase by 12 in 
Tables, Critical Events, Trends, and 
Report Summary. In addition, different 
Saved Strips will be selected.

Those changes in Settings that require 
an update are all those in the What 
Strips to Auto Save and How Often 
Strips Auto Save windows, along with 
these settings in the Scanning Criteria 
window - Tachycardia, Bradycardia, 
SVT and VTAC rates; Pause length; 
Count Irregular HR as Afib; Interval 

size; and SVPB and VPB prematurity 
settings.

Note: Because update is required 
after a change in some Settings, be 
sure to make any changes to the 
Settings before you edit Saved Strips, 
Tables and Report Summary for the 
final report. Bin, template or beat 
editing done before the update will 
not be lost.

If an Update button does not appear in 
the Review toolbar, it means the Auto-
matically Update feature is turned on in 
the Preferences window. When you 
make a Settings change that requires an 
update, the update will occur automati-
cally when you close the Settings win-
dow.

If an Update button appears in your 
Review toolbar, the Automatic Update 
feature is turned off in the Preferences 
window. That means that after some 
editing changes, you must click the 
Update button to incorporate your 
changes. After you make changes that 
require an update, the Update button 
will blink red as a reminder that you 
must at some point click it.

Note: Whether the Update button 
appears in the Review toolbar depends 
on the “Automatically update tables” 
setting in the Preferences window. If 
the software is set to automatically 
update, the button does not appear; if 
you must update the data after 
making changes, the button appears.
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Oximetry analysis
The DR180 Series of recorders can be 
used to record oximetry. When you 
attach your optional oximetry hook-up 
equipment to your DR180 Series 
recorder, it becomes a OxyHolter 
recorder. When analyzing an 
OxyHolter recording, oximetry 
analysis is done automatically when 
you start analysis from the Patient 
Information screen. 

Note: When Oximetry is recorded, no 
pacemaker spikes will appear on the 
Holter recording and no pacemaker 
analysis will be done. 

The oximetry data appears in the chan-
nel 3 area of all ECG displays. This 
includes a color-coded (based on the 
beat label, so usually green) trend of 
the SpO2 data, with a vertical scale of 
60 to 100 percent saturation; artifact in 
that trend is indicated by vertical hash 
marks. Pulse oximetry data is dis-
played as the white trend above the 
SpO2 trend.

The Oximetry trend window shows the 
oximetry heart rate data superimposed 
on the heart rate trend. 

The Oximetry trend window 
also shows desaturation 
events highlighted in red 
along the oximetry trend. The 
desaturation events are 
defined by the settings in the 
Oximetry window in the Set-
tings menu.

The adjustments you can make include:

• Desaturation threshold (percent) 
defines the oxygen level (SpO2 
value) that every reading during a 
desaturation event must be below. 
The duration of an event is defined 
as a time period during which no 
reading was above this level.

• Max. desaturation nadir defines 
the SpO2 level that must be met for 
an event to be identified as a desatu-
ration event. During the event, at 
least one reading must drop to this 
level.

• Min. overall desaturation length 
(in seconds) determines how long 
the readings must remain at or 
below the Desaturation threshold to 
be considered a desaturation event.

• Max. length of artifact in a desat-
uration (in seconds) defines the 
maximum amount of sequential arti-
fact that can occur during a desatu-
ration event and still have it reported 
as an event.

• Min. separation of artifact seg-
ments in desaturation (in seconds) 
defines how close periods of artifact 
can be within a desaturation event 
and still have it reported as an event.

Oximetry window in Settings
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ST segment analysis
ST segment analysis includes these 
steps (which are each explained in 
depth in the following pages):

1. Setting ST markers. This is done 
automatically by the software, but 
you can adjust the markers for any 
patient.

2. Measuring the ST segment on all 
three channels of every normal beat. 
This is done automatically. If you 
relabel normal beats to some other 
label, the ST segment analysis will 
be re-done automatically.

3. Plotting ST data in 30-second 
increments. All normal beats within 
each 30-second time period are 
averaged.

4. Establishing ST baseline for the 
patient throughout the Holter period. 
The software does this automati-
cally and plots it in blue on the ST 
trends in the Trends window.

5. Comparing the 30-second ST seg-
ment data measured with the base-
line at the same time. A difference 
of at least 1 millimeter in any chan-
nel is considered to be an event. 
Again, the software does this auto-
matically.

6. Identifying ST events. ST events 
are listed in the ST event table in the 
Tables window. This is automati-
cally compiled for you, but you can 
edit any of the fields within the 
table.

7. Documenting ST events. You 
determine which strips are saved to 
document each event, based on the 
settings in the What Strips to Auto 

Save window. How many ST events 
are documented is determined in the 
How Often to Auto Save window. 

Note: The procedure does not include 
calibrating the signal because the 
data is recorded at 1 centimeter per 
millivolt, the standard for ST segment 
analysis.

Setting ST markers

To review the locations of the ST 
markers used during analysis:

1.  Select Review > Calibration. The 
Calibration window opens display-
ing the calibration pulse, a series of 
eight 1-millivolt square waves.

2. Click the radio button to the left of 
“ST Marker” to change the display 
to ECG and three colored, vertical 
markers, which include:

• the left-hand marker (cobalt blue) 
indicates where iso-
electric is in the 
baseline preceding 
the QRS complex;

• the middle marker 
(yellow) is located 
at or just following 
the j-point (where 
the QRS ends and 
the ST segment 
begins); and

• the right-hand marker (light blue) is 
located during the ST segment.

Note: If the ECG displayed is not 
clean and representative of the 
patient’s normal, click the down 
arrow of the scroll bar to jump 
forward to different ECG.

The three ST marke
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Co
ST 1, 2 and 3 fields

3. If the markers are not located where 
you want them, drag them to move 
them to the appropriate locations. 
The ST segment measurement can 
be made at the location of either the 
j-point or the ST segment marker, 
while the other of the two is used to 
indicate the slope of the ST seg-
ment. The time between those two 
markers is listed in the field labeled 
“ST Segment (ms).” Be sure to 
locate each marker based on your 
facility’s protocol. 

Note: Each marker for each channel 
moves independently so that you can 
precisely position the markers based 
on each channel’s morphology.

4. Once each marker is in the appropri-
ate location, click the radio button 
next to Done. If you have made 
changes to either the Gain or the ST 
Marker window, a window opens to 
ask whether it’s okay to continue. 
Click on Yes to make the change 
and continue. Click No to cancel 

your changes and retain the previous 
information.

5. To exit from the ST Marker window 
without saving your changes, click 
the radio button next to Cancel.

Measuring the ST segment

This is performed automatically for all 
three channels of ECG. Whether the 
ST segment measurement is done at the 
position of the j-point or the ST seg-
ment marker is determined by the set-
ting “ST measurement” in the 
Preferences window. See Chapter 8 for 
details of the Preferences settings and 
their use.

The ST segment measurement is aver-
aged in 30-second increments through-
out the Holter period. Only normals not 
contaminated by artifact are included 
in each average. At least eight valid 
measurements must be made within a 
30-second period for it to be included; 
if there are fewer than eight clean nor-
mal beats, the 30-second increment is 
considered artifact.

For any par-
ticular beat, 
you can mea-
sure the ST 
segment manually by going to the Page 
display and selecting the beat as the 
current beat. In the Expanded display, 
drag the left marker to define iso-elec-
tric and the right marker to the appro-
priate location of the ST segment. The 
vertical difference between where the 
two markers intersect each channel of 
ECG is listed in the ST 1, 2 and 3 fields 
in the Expanded toolbar.

Plotting ST segment data

The data for all three channels is plot-
ted in the ST level display of the 
Trends window. To display it, select 

nfirm window
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Trends from the Review toolbar and 
then select ST level in the Type field.

The top trend is minute-by-minute 
heart rate. Immediately below that is 
the ST trend for channel 1, then chan-
nel 2, with channel 3 on the bottom. 
Each trend shows the patient’s calcu-
lated baseline as a cobalt blue trend, 
with the patient’s ST measurement 
plotted in green and the slope of the ST 
segment indicated by a red vertical 
line.

The software calculates the patient’s 
ST baseline from the patient’s normal 
ST segment measurements as the Hol-
tered period progresses. ST segment 
changes that are caused by positional 
changes result in changes in the 
patient’s baseline, and are not usually 
considered ST events themselves. The 
patient’s baseline during what ends up 
being an ST event is interpolated from 
the baseline before and after the event. 

The significance of establishing a 
patient’s baseline is that it means that 
normal is not always defined as iso-
electric (that is, with no voltage) and 
that significant changes are relative to 
the patient’s baseline, not to iso-elec-
tric.

Identifying ST events

The ST analysis software looks 
through the ST level trends, comparing 
the ST trends to the patient’s baseline 
trends, to find episodes of significant 
ST segment changes.

For an incident to be called an ST 
event, at least one 30-second ST seg-
ment data point must be at least 1 milli-
meter different than the patient’s 
baseline for that channel at that time-
of-day. A depression is a change of at 
least 1 millimeter in the negative direc-
tion, while an elevation is a change of 
at least 1 millimeter in the positive 
direction.

In the ST level trends, incidents that 
are flagged as ST segment events are 
indicated by a light blue horizontal line 
above the appropriate channel and last-
ing as long as the event. 

The events are listed in the ST event 
table in the Tables window. To display 
it, click Tables in the Review toolbar, 
then click on ST event in the Tables list 
at the right of the Tables window. In 
that table, the description for each 
event includes:

• Channel - the channel in which the 
event was detected

• Onset - the time-of-day at the start 
of the event (defined as when the 
change in ST segment passes 
through the point 0.5-millimeter dif-
ferent from the patient’s baseline)

• End - the time-of-day at the end of 
the event (defined as when the 
change in ST segment returns to 
within 0.5-millimeters different 
from the patient’s baseline)

• Duration - the difference between 
the end and the onset times

• Max HR - the maximum heart rate 
calculated during the duration of the 
event
LX Analysis                             33



Chapter 3: Holter Analysis

34
• Max ST deviation Time - the time-
of-day at the event’s maximum 
deviation from the patient’s baseline

• Max ST deviation HR - the heart 
rate during the event’s maximum 
deviation from the patient’s baseline

• Max ST deviation Baseline - the 
ST segment measurement’s devia-
tion from the patient’s baseline at 
the point of maximum deviation

• Max ST deviation Iso-electric - the 
ST segment measurement’s devia-
tion from iso-electric at the point of 
maximum deviation

• Max ST deviation Slope - the slope 
of the ST segment event at the point 
of maximum deviation (+ indicates 
upsloping; - indicates downsloping; 
0 indicates horizontal)

• Integral - the calculation that 
reflects the area under the slope 
between the ST trend and the 
patient’s baseline during the event

Note: If an event includes both a 
positive component and a negative 
one, the integral is actually less than 
the true area. Although we report the 
absolute value, the integral calcu-
lation can result in a “negative” area, 
which when added to a positive area 
can cancel some or all of it.

All of the information listed in the ST 
event table can be edited by clicking 
the Edit button to open the ST Event 
Edit window and making the changes 
you desire. To edit an entry, drag 
across the existing entry and type the 
information to replace it. When fin-
ished, click OK to save your changes 
and exit. Click Cancel to close the win-
dow without saving the changes.

To add an ST event, click the Add but-
ton. The ST Event Edit window opens 
with blank fields. Type the appropriate 
information in each of the fields. Click 
OK to save the event and exit. Click 
Cancel to exit without saving the 
event.To delete an ST event from the 
table, click on the event to be deleted, 
then click the Delete button. The event 
disappears.

To print the table, click the Print but-
ton. To close the Tables window, click 
OK.

Documenting ST events

You control what strips are saved to 
document ST segment events using a 
combination of settings in the What 
Strips to Auto Save and How Often 
Strips Auto Save windows.ST Event Edit window
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Pacemaker activity is recorded on 
NEMon Holter Recorders without dis-
torting the patient’s ECG, by removing 
the effects of the pacemaker spike and 
replacing it with a pacemaker marker. 
That marker, when re-introduced to the 
ECG when the flashcard is read by the 
analysis software, appears as a vertical 
spike in the precise location of the orig-
inal pacemaker spike.

Note: When Oximetry is recorded, no 
pacemaker spikes will appear on the 
Holter recording and no pacemaker 
analysis will be done. 

For the software to do a proper analysis 
of the pacemaker activity during the 
Holter period, the pacemaker settings 
in the Scanning Criteria window must 
be set properly. They include:

• Pacemaker type, which contains 
four settings that allow the software 
to expect certain behavior:

1. Not paced means that the software 
will not identify any pacemaker 
spikes, beats or failures.

2. VVI means that each paced beat will 
be preceded by a single spike. All 
paced beats are counted as ventricu-
lar paced.

3. AV sequential means that paced 
beats should be preceded by two 
pacemaker spikes, one atrial and one 
ventricular. 

4. DDD means that paced beats can be 
preceded by either a one or two 
pacemaker spikes. Depending on the 
spike’s location relative to the fol-
lowing R-wave, a beat preceded by 
a single spike will be called either 
atrial paced or ventricular paced, 
while a beat preceded by two spikes 
will be counted as AV paced. 

• Minimum heart rate refers to the 
minimum rate allowed by the pace-
maker. If the pacemaker does not 
fire appropriately and there is a RR 
interval longer than the patient 
should experience, the Inhibition 
label appears.

• Maximum heart rate refers to the 
maximum rate initiated by the pace-
maker. If the pacemaker fires early, 
typically because it did not sense the 
previous beat, it would result in a 

Diagram of pacemaker interval settings
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faster rate, the Sense failure label 
appears.

• Maximum vent. spike to R inter-
val sets the maximum time between 
the firing of the second pacemaker 
spike and the following R-wave. If 
the second spike appears and is not 
followed by an R-wave in this 
amount of time, the Capture failure 
label appears.

• Maximum atrial spike to R inter-
val sets the limit for how long is 
allowed between a single spike and 
the subsequent R-wave. If a single 
spike occurs and the following R-
wave is not within this amount of 
time, the Capture failure label 
appears.

• Paced beat and the beat after can 
be called a SVPB is a setting that 
allows you to identify early beats 
following a paced beat as SVPBs 
because they were premature, even 
if they themselves are paced beats. 
Click on the check box to turn it off 
and on.

Pacemaker labels

Beats can be identified and counted 
with the following labels (refer to the 
diagram on the previous page):

• A paced for a beat that is paced just 
in the atrium. The atrial spike is 
determined to be the one that occurs 
well before the QRS, falling before 
the “Maximum ventricular spike to 
R interval,” but within the “Maxi-
mum atrial spike to R interval.”

• V paced for a beat that is paced just 
in the ventricle. With pacemaker 
type set to DDD or AV Sequential, 

the ventricular spike is determined 
to be the one that occurs during the 
“Maximum ventricular spike to R 
interval.” This label also includes all 
paced beats with the pacemaker type 
set to VVI and all beats without 
pacemaker spikes that are manually 
labeled “Paced.”

• AV paced for a beat that is paced in 
both the atrium and the ventricle, 
with the atrial and ventricular spikes 
identified in the same way as 
described above.

• Sense failure means that the pace-
maker (1) did not sense a QRS that 
occurred and (2) fired, resulting in a 
shorter-than-programmed R-to-
spike interval. The label can happen 
under three scenarios:

1. Pacemaker type  is set to DDD and 
two pacemaker spikes occur, with 
less than the “Maximum atrial spike 
to R interval” between them, and 
with the second spike more than 20 
milliseconds after the QRS.

2. A single spike is more than 20 milli-
seconds after the QRS.

3. The time between the preceding 
QRS and the next pacemaker spike 
is less than 60 divided by the “Maxi-
mum heart rate;” that is, the pace-
maker fired early.

• Inhibition refers to inappropriate 
inhibition of the pacemaker, result-
ing in a longer-than-programmed 
RR interval. This label appears if the 
time between the preceding QRS 
and the next pacemaker spike is 
greater than 60 divided by the “Min-
imum heart rate” setting; that is, the 
pacemaker fired late.
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• Capture failure means that the 
pacemaker has fired, but there is no 
subsequent QRS within the allotted 
interval. The label, which falls on 
the detected QRS after the missing 
QRS, appears in four scenarios:

1. The pacemaker type is DDD or AV 
Sequential and there are two pace-
maker spikes, with the time between 
them less than “Maximum atrial 
spike to R interval” and the time 
between the second spike to the 
QRS greater than the “Maximum 
ventricular spike to R interval” set-
ting.

2. The pacemaker type is DDD or AV 
Sequential and there is only one 
pacemaker spike, with the time 
between the spike and the following 
QRS greater than the “Maximum 
atrial spike to R interval” setting.

3. The pacemaker type is VVI and the 
time between the pacemaker spike 
and the following QRS is greater 
than the “Maximum ventricular 
spike to R interval” setting.

4. There are two pacemaker spikes that 
are more than the “Maximum atrial 
spike to R interval” apart and the 
time from the first pacemaker spike 
to the following QRS is greater than 
the “Maximum ventricular spike to 
R interval” setting.

Pacemaker table

Pacemaker counts are itemized in the 
Paced table in the Tables window. To 
display it, click Tables in the Review 
toolbar, then click on Paced in the 
Tables list at the right of the Tables 

window. The Paced table is an interval 
table and the reported data includes:

• Time-of-day - the time-of-day at the 
start of the interval;

• Total Beats - the total number of 
beats identified and counted within 
the interval, not including artifact;

• Time Analyzed - the total amount 
of time analyzed during the interval; 
this does not including periods that 
are considered to be artifact;

• Total Paced - total of the following 
3 fields;

• Atrial Only - paced beats that were 
determined to be paced only in the 
atrium, not the ventricle;

• Vent(ricular) Only - paced beats 
that were determined to be paced 
only in the ventricle, not the atrium;

• AV - paced beats that were deter-
mined to be paced in both atrial and 
ventricular chambers;

• Sense Failure - the number of times 
sense failures occurred (these are 
defined in the previous section);

• Capture Failure - the number of 
times capture failures occurred 
(these are defined in the previous 
section);

• Inhibit(ion) - the number of times 
the pacemaker was inappropriately 
inhibited from firing (this is defined 
in the previous section).

• Paced% - the percentage of paced 
beats out of all beats in that interval.

The fields in this table can be edited as 
described in the “Editing table entries” 
section of the following chapter.
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4 REVIEW METHODS
The Holter signal saved for a patient can be reviewed on the monitor of your computer in several 
ways. You can review and edit (1) the templates established during analysis, (2) the most signifi-
cant events identified during analysis, (3) on-screen full disclosure of all the ECG, (4) graphs 
showing the heart rate and RR interval data, (5) strips saved for the final report, (6) superimposi-
tion, and (7) tables compiled for the report.
Holter LX Analy
Color coding
Throughout the LX Analysis software, the ECG is color-coded 
based on what the system has labeled each beat: 

• Green: Beats the software has identified as normal.

• Yellow: Beats identified as supraventricular premature beats 
(SVPBs). They have a normal morphology, but fall early. 

• Red: Beats identified as ventricular premature beats (VPBs). 
They differ significantly from the normal; they are not neces-
sarily premature.

• White: Beats identified as pauses, based on the definition in the 
Scanning Criteria window. The white overrides any other color 
that the beat may also qualify for (e.g., red because it’s a VPB).

• Light blue (cyan): Signal that appears to be contaminated by 
artifact. 

• Cobalt blue: Beats identified as paced.

All data must be reviewed carefully to ensure that you agree with 
the beat labels the software has selected; if you do not agree, you 
can change them and their color will change appropriately.

In addition to the labels the software can provide for each beat, 
there are some labels only you can use to relabel beats. These are:

• Aberrant: Use this label to identify and counts beats as 
aberrantly conducted SVPBs. All matches to the template that 
meet the SVPB prematurity requirement will be counted as 
Aberrant SVPBs and colored yellow, like the other SVPBs. This 
can be used as either a template or a beat label.
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Ventri
• Questionable (Unknown): Use this 
label to separate out beats you 
cannot identify and keep them from 
being included in another category. 
They are colored green, like 
normals. This can be used as a 
template or a beat label.

• T-wave: Use this label if the 
software has identified a portion of 
the signal as a QRS, but it is not. 
This will remove the beat from the 
counts and will merge its RR 
interval with the preceding RR 
interval. The signal will take the 
color of whatever beat precedes it. 
This can only be a beat label.

Reviewing Bins (Pro and 
Enhanced Plus Levels) 
During analysis, the LX software first 
determines what the patient’s normal 
QRS complex looks like and estab-
lishes a template called “normal.” Each 
beat after that is compared to the nor-
mal template; matches to that template 
are also called normal, while a similar 
but slightly different morphology will 
establish a new template, also called 
normal. A QRS complex that differs 
more significantly from the normal 
template will establish a template 
called “ventricular.” A new template is 
established for each different morphol-
ogy identified by the software. Subse-
quent matches to a template get labeled 
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ates
based on the template label, the timing 
of the beat, and other criteria.

After analysis, the templates that gen-
erally look alike are grouped together 
in “bins.” You can review these bins by 
morphology, that is, all normal bins or 
all ventricular bins. Within the Bin 
window, you can also review by tem-
plate, displaying all the templates 
within each bin, one bin after the other. 
You can also review all matches to 
each template, displaying them one 
template after another. 

Description of the Bin window

The Bin window opens with all bins of 
a particular morphology (normal, ven-
tricular, aberrant, paced, questionable 
or artifact) displayed, up to a maximum 
of 16 bins. The morphology type is 
indicated in the Morph(ology) field, 
along with an indication of how many 
templates of that type were established 
for this patient and how many total 
beats were counted as this type. For 
example, in the figure on the previous 
page, there are 9 ventricular bins made 
up of 12 templates, and a total of 7,855 
beats matched the templates in those 
bins.

To change the morphology displayed, 
click on the arrow in the Morph field to 
display your choices, then click on the 
type you want displayed.

In each bin display, the three channels 
of the center beat are surrounded by an 
outlined box. That beat is the one that 
is in the bin; the surrounding ECG is 
displayed to show how the beat 
occurred, but is not included in the bin. 
The number in the left corner of each 

bin indicates how many total beats 
matched the templates within that bin.

To select a particular bin, click on it. 
The time-of-day becomes outlined and 
the Bin # and Matches fields now dis-
play data for that particular bin.

Relabeling a bin

To relabel a bin and all of its contents 
(all templates and matches), click on 
the bin to select it, then click on one of 
the label buttons under the Morphology 
field. The relabel buttons are not active 
unless one or more bins are selected.

The relabel buttons include: 

• A for artifact

• V for ventricular

• N for normal

• P for paced. (appears only if 
Pacemaker mode is on in Scanning 
Criteria)

• B for aberrant 

• Q for questionable/unknown

Note: No S label buttons appears 
here because an SVPB matches a 
normal template, but is early.

To relabel multiple bins, click on each 
of the bins you want to relabel and then 
click on the appropriate relabel button. 
To relabel all of the displayed bins, 
click the All button to select all the dis-

Relabel buttons for bins and templ
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Radi
o buttons in Bin window

played bins and then click the appropri-
ate relabel button.

To undo a relabel, click on the Undo 
button. It will restore the bins to their 
state before the last relabel, regardless 
of whether it was a single bin, multiple 
bins, or all bins that were relabeled.

Changing levels in the Bin 
window

To display the templates within a par-
ticular bin, click on the bin and then 
click on the Templates radio button.

Note: Moving from one level of the 
Bin window to the next can also be 
done by double-clicking on the ECG 
in the bin, template, or beats display. 
Each double-click changes the radio 
button position one button to the 
right.

Note: When a scroll bar appears to 
the right of a field or window, you 
have the option of using it or using 
the scroll button on your mouse, if 
you have one.

Template display

The individual templates are presented 
with two additional pieces of informa-
tion just underneath each template - the 
number of matches to the template and 
the time-of-day the template was estab-
lished, that is, the first occurrence of 
that template.

When you click to highlight a particu-
lar template, the Strip # and Matches 
fields update to reflect information 
about the current template.

The template display contains up to 12 
templates that matched the current bin. 
If more than 12 templates fell into that 
bin, you can access additional pages of 
templates by using the PageDown key, 
the scroll bar or the Scan button. If you 
use the PageDown key, once you reach 
the last page of templates in the current 
bin, PageDown will display the tem-
plates that matched the next sequential 
bin of the same morphology type.

To display the templates in a different 
bin, click the up and down arrows of 
the Bin # field.

Relabeling a template

To relabel a template and all matches to 
it, click on the template to select it (the 
time-of-day of a selected template is 
surrounded by a yellow box), then 
click on a label button under the Mor-
phology field.

To relabel multiple templates, click on 
each of the templates you want to rela-
bel and then click on the appropriate 
relabel button. To relabel all of the dis-
played templates, click the All button 
to select all the displayed templates and 
then click the appropriate relabel but-
ton.

Note: If there are multiple pages of 
templates within a bin and you relabel 
one or more of them, blank spaces are 
temporarily left where the template(s) 
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Data fiel
originally appeared. After paging up 
or down and returning, the blank 
spaces are gone.

To undo a relabel, click on the Undo 
button. It will restore the templates to 
their state before the last relabel.

Beats display

Clicking the Beats radio button dis-
plays up to 24 of the beats that matched 
the current template. Use the Page-
Down, the Scan button, or the scroll 
bar to display additional matches to the 
template. The display includes the 
time-of-day each beat occurred, the 
template number the beats matched (in 
the Template field), and the total 
matches to the template (Strip #).

For the current beat, two blue vertical 
markers appear. The markers can be 
used to make measurements, which 
appear in the data fields below the 
large time-of-day field. 

Drag the blue markers to appropriate 
locations to have the data fields dis-
play:

• HR (2RR) field shows the heart rate 
calculation based on the blue 
markers being two RR intervals 
apart. 

• Time field indicates the time (in 
seconds) between the blue markers.

• ST 1 field displays the vertical 
difference between where the 
markers intersect channel 1. The left 
marker should define iso-electric 

and the right marker should be 
located where you want the ST 
measurement made.

• ST 2 field displays the vertical 
difference between where the 
markers intersect channel 2. They 
should be positioned as indicated for 
channel 1.

• ST 3 field displays the vertical 
difference between where the 
markers intersect channel 3. They 
should be positioned as indicated for 
channel 1.

Click the Both check box to drag the 
markers keeping them the same dis-
tance apart. Click the Both box again to 
move the markers separately.

To keep the calipers in the same loca-
tions as you move through different 
screens of ECG, click the check box 
next to Lock; the calipers will stay in 
the indicated locations unless you 
move them again. Click again to turn 
off.

Relabeling a beat

The Beats window in Bin allows only 
single-beat editing, which removes a 
beat from its template and relabels just 
that beat. To relabel a beat this way, 
click on the beat to select it, then click 
on one of the relabel buttons under the 
Morphology field. 

In addition to the relabel buttons 
defined in the “Relabeling a bin” sec-

Relabel buttons for beats and strips

ds in Beats and Strips displays
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tion earlier in this chapter, the relabel 
buttons for beats and strips include:

• S for supraventricular

• T for T-wave

To relabel multiple beats, click on each 
of them and then click on the correct 
relabel button.

To undo a relabel, click on the Undo 
button. It will restore the beats to their 
state before the last relabel.

Saving sample strips for the 
report

As you review the ECG, you can 
choose to manually save sample strips 
for the report. The 7.5-second sample 
strips are printed as full-sized, 25-mm/
second ECG on a background grid. To 
save a strip containing one of the dis-
played beats, click on the beat you 
want at the center of the strip to make it 
the current beat, and then click Keep; 
the Keep window opens. To label the 
strip, either type the label in the 
Description field or select a label from 
the scrolling list; then click OK to save 
the strip. To close the Keep window 
without saving the strip, click Cancel.

For more information about the Keep 
window, see “Saving sample strips for 
the report” in the Page window section 
of this chapter.

Printing the ECG now

To print a strip of ECG centered on a 
displayed beat, along with a page of 
full disclosure of the surrounding 
rhythm, use the Print button. When the 

Print window opens, click the left-hand 
button to print with the current beat 
centered on the page of full disclosure, 
or click the middle button to print with 
the current beat on the first line of the 
page. Click Cancel to close the window 
without printing.

Strips display

The Strips display 
provides a full-
screen display of 
the current beat. All 
buttons, fields, and 
markers work as 
described in the previous section, 
“Beats display,” with one addition - the 
Display field. This controls the amount 
of time that appears in the full-screen 
display. Click on the arrow in the field 
to show your choices, and click on 
your choice to change the amount of 
time.

Reviewing Critical 
Events
The most significant events that 
occurred during the Holter test appear 
in the Critical Events window. You can 
review and edit them as needed in the 
Critical Events window. Each type of 
critical event has a number associated 
with it - the number of events of that 
type that were identified for this 
patient. Every event of each type can 
be displayed, either one at a time (full-
sized) or 12 at a time (miniature). 

To select a type to be displayed, use the 
scroll bar to scroll through the list and 

Display field choices
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Reviewing Critical Events

Critica
display your choice, and then click on 
your selection.

Note: A beat that appears in one 
category of Critical Events does not 
appear in all other applicable 
categories. For example, if a VPB 
appears in Bigeminy, it does not 
appear in VPB; if a paced beat 
appears in Sense Failure, it does not 
appear in any other paced category. 
Therefore, do not rely on the counts 
in Critical Events to provide compre-
hensive totals.

To move through the displayed epi-
sodes, use the PageUp and PageDown 
keys, the scroll bar, the scroll button on 
your mouse, or click Scan to automati-
cally move from one display to the 
next. Click the Scan button again to 
stop the display.

When a single episode is displayed, 
click the Multiple button to display 12 
at a time. When multiple episodes are 
displayed, the button label changes to 
“Single;” click that to display just one 
episode. You can also double-click on a 
strip to toggle back and forth between 
the single and multiple displays.

l Events window - multiple display
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Each event is labeled with time-of-day 
and RR interval. In addition, if the 
ECG appears in a strip saved for the 
printed report, the word “saved” 
appears to the right of the RR interval.

ST events

ST events are in the Critical Events list. 
If you click ST Events, the strips show-
ing the maximum ST deviation during 
each event are displayed. In addition, 
an ST event table button appears; that 
allows you to display a table listing the 
ST events that were found on this 
Holter test.

HR strips (Enhanced Plus and 
Pro Levels)

Critical Events includes this display of 
all the ECG recorded during the Holter 
period, in 7.5-second strips. While 
some beats may appear more than once 
in other categories (because they are 
adjacent to the current beat being dis-
played), this category displays each 
beat in one strip only. The heart rate 
listed is based on all beats present in 
the displayed strip.

Saved strips

Saved strips are in the Critical Events 
list so that you can review the strips 
saved for the final report without leav-
ing the Critical Events window.

Changing the amount of time 
displayed

The Display field controls the amount 
of time that appears in the single event 
display. Click on the arrow in the field 

to show your choices, and click on 
your choice to change the amount of 
time displayed.

Saving sample strips for the 
report

As you review the ECG, you can 
choose to manually save sample strips 
for the report. The 7.5-second sample 
strips are printed as full-sized, 25 mm/
second ECG on a background grid. 

To save a strip containing one of the 
displayed beats, click on the beat you 
want at the center of the strip to make it 
the current beat, and then click Keep; 
the Keep window opens. To keep it 
with the current label, click OK. To 
relabel the strip, type the label in the 
Description field or select a label from 
the scrolling list; then click OK to save 
the strip. 

To save multiple strips all with the 
same label, click on each one to be 
saved, then click the Keep button and 
click on the button that indicates multi-
ple strips - it will read “x strips,” with x 
equal to the number of strips you 
selected before clicking Keep.

Any strips you manually save are 
included in the Saved Strips window.

If you decide to close the Keep window 
without saving the strip, click Cancel.

For more information about the Keep 
window, see “Saving sample strips for 
the report” in the Page window section 
of this chapter.
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Reviewing Critical Events
Sorting episodes within a type 
(Enhanced Plus and Pro only)

The Sort field lets you change the order 
of the episodes within each type. You 
can choose “RR interval” to put them 
in order based on the RR interval, from 
shortest to longest, starting with the 
current beat. Unlike RR interval label-
ing elsewhere in the software, which 
labels the interval length from the cur-
rent beat to the following beat, sorting 
by RR interval in Critical Events sorts 
based on the RR interval preceding the 
current beat; in that way, you can 
review the most premature beats of a 
type or the latest beats of a type. 

The “Time” setting orders the episodes 
based on the time-of-day of the event, 
from earliest to latest.

The “24 hours” setting also orders 
them by time-of-day, but the histogram 
at the top of the window is divided into 
hourly intervals. See the “Histograms” 
section below for details.

To change the setting, use the scroll bar 
to display additional choices and then 
click on your choice.

Histograms

The top portion of the Critical Events 
window presents a histogram showing 
the distribution of the events within the 
type displayed - either an RR histo-
gram or a 24-hour histogram. 

The RR histogram plots the length of 
the RR interval preceding each episode 
of the displayed type. The number of 
events is on the vertical axis (with a log 

scale) and RR interval (in millisec-
onds) is on the horizontal axis. The 
blue marker is located at the position of 
the current event. To display the event 
associated with an alternate RR inter-
val, click on the RR interval in the his-
togram; the appropriate event will 
appear as the active event in the bottom 
portion of the window.

The 24-hour histogram shows how 
many episodes of the displayed type 
occurred during each 10-minute inter-
val of the recording. The blue arrow is 
located at the position of the current 
event. To display the events associated 
with a different time-of-day, click on 
the histogram at that time; the appro-
priate event will appear as the active 
event in the bottom portion of the win-
dow.

Which histogram displays is based on 
the setting in the Sort field. The set-
tings “RR interval” and “Time” display 
the RR histogram; the setting “24 

24-hour histogram
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Data fie
lds

hours” displays the time-of-day histo-
gram shown above.

Data fields

The data fields in this window are just 

like those in all other Review windows. 
Two blue vertical markers (calipers) 
appear within the current episode. The 
markers can be used to make measure-
ments, which appear in the data fields. 

Drag the blue markers to appropriate 
locations to have the data fields dis-
play:

• HR (2RR) field shows the heart rate 
calculation based on the blue 
markers being two RR intervals 
apart. 

• The Time field indicates the time (in 
seconds) between the blue markers.

• The ST 1 field displays the vertical 
difference between where the 
markers intersect channel 1. The left 
marker should define iso-electric 
and the right marker should be 
located where you want the ST 
measurement made.

• The ST 2 field displays the vertical 
difference between where the 
markers intersect channel 2. They 
should be positioned as indicated for 
channel 1.

• The ST 3 field displays the vertical 
difference between where the 
markers intersect channel 3. They 
should be positioned as indicated for 
channel 1.

Click the Both check box to drag the 
markers keeping them the same dis-
tance apart. Click the Both box again to 
move the markers separately.

To keep the calipers in the same loca-
tions as you move through different 
screens of ECG, click the check box 
next to Lock; the calipers will stay in 
the indicated locations unless you 
move them again. Click to turn off.

Printing the ECG now

To print a strip of ECG centered on a 
displayed beat, along with a page of 
full disclosure of the surrounding 
rhythm, use the Print button. When the 
Print window opens, click the left-hand 
button to print with the current beat 
centered on the page of full disclosure, 
or click the middle button to print with 
the current beat on the first line of the 
page. Click Cancel to close the window 
without printing.

Relabeling in Critical Events

All relabeling done in the Critical 
Events window is single-beat editing. 
Only the current beat within the 
selected event is relabeled when you 
use these relabel buttons:

• A for artifact

• V for ventricular

• N for normal 

Print window
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